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Skills for Success w/ Microsoft Excel 2013 Comprehensive (Townsend) 

Chapter 2   Insert Summary Functions and Create Charts 

1) A ________ is a group of numbers, text, dates, or time periods that come in succession. 

A) chain 

B) sequence 

C) series 

D) succession 

Answer:  C 

Diff: 2 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

2) The Excel feature used to automatically adjust column width to the longest column entry is 

________. 

A) AutoFit 

B) AutoComplete 

C) AutoAdjust 

D) AutoFill 

Answer:  A 

Diff: 2 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

3) The displayed value of a cell is replaced with a series of # symbols when ________. 

A) there is an error in the underlying formula 

B) the name of a function is misspelled 

C) the column is too narrow to display the entire value 

D) a cell in the underlying formula has no value 

Answer:  C 

Diff: 2 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

4) Which symbol is the error indicator that appears in a cell having a formula that has broken a 

rule? 

A) green triangle 

B) green square 

C) red exclamation point 

D) yellow caution sign 

Answer:  A 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 
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5) When a section of a worksheet displaying numeric values is selected, the ________ appears; 

this is used to apply conditional formatting or to insert a chart or table based on the selected 

content. 

A) Quick Access Lens button 

B) Quick Analysis Lens button 

C) Quick Analysis Lens contextual tab 

D) Quick Format Lens button 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

6) Which is NOT a category in the Quick Analysis gallery? 

A) Formatting 

B) Charts 

C) AutoSum 

D) Tables 

Answer:  C 

Diff: 3 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

7) A cell that remains the same when it is copied or filled to other cells is a(n) ________. 

A) relative cell reference 

B) constant cell reference 

C) fixed cell reference 

D) absolute cell reference 

Answer:  D 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

8) The ________ outlines all the cells referenced in a formula. 

A) error value 

B) range finder 

C) error indicator 

D) range detector 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

9) A message that appears in a cell when a formula cannot perform the specified calculations is 

a(n) ________. 

A) error value 

B) failure message 

C) edit message 

D) error indicator 

Answer:  A 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 
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10) The number of decimals places and the appearance commas, dollar signs, or other symbols 

are features of number ________. 

A) format 

B) style 

C) layout 

D) alignment 

Answer:  A 

Diff: 2 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 

11) The ________ format does not display commas or trailing zeros to the right of a decimal 

point. 

A) Currency 

B) General 

C) Accounting 

D) Percentage 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 

12) Moving between worksheets in a workbook is done by clicking on ________. 

A) the title bar 

B) the name box 

C) a worksheet tab 

D) the new option from the Quick Access Toolbar 

Answer:  C 

Diff: 2 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 

13) The ________ is a statistical function that adds a group of values and then divides the result 

by the number of values in the group. 

A) SUM 

B) AVERAGE 

C) MAX 

D) MIN 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 
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14) In a function, the range in parentheses is the ________. 

A) argument 

B) variable 

C) underlying value 

D) display value 

Answer:  A 

Diff: 2 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

15) When the function argument is automatically entered by Excel, the argument is ________. 

A) a relative reference 

B) an absolute reference 

C) entered in green text 

D) entered in red text 

Answer:  A 

Diff: 3 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

16) The ________ suggests functions that match the initial characters being entered by a user. 

A) AutoSum arrow 

B) Formula AutoComplete 

C) Formula Preview 

D) Formula AutoFill 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 5: Insert the MIN and MAX Functions 

17) When the Function AutoComplete list is used to enter the MAX function into an active cell, 

________. 

A) single-click on the name of the function in the list 

B) right-click on the name of the function and click Insert 

C) double-click on the name of the function in the list 

D) click and drag the name of the function into the active cell 

Answer:  C 

Diff: 3 

Skill:  Excel Chapter 2, Skill 5: Insert the MIN and MAX Functions 

18) A ________ chart is used to illustrate comparisons of related numbers. 

A) pie 

B) column 

C) line 

D) scatter 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 
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19) The Quick Analysis Lens button appears to the right of ________. 

A) a selected range of cells 

B) a sheet tab 

C) the Name Box 

D) the formula bar 

Answer:  A 

Diff: 3 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

20) The ________, the line that borders the chart plot border area, is used as a frame of reference 

for measurement. 

A) chart border 

B) gridline 

C) category border 

D) axis 

Answer:  D 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

21) In a worksheet, each cell in the blue range finder is a(n) ________. 

A) data marker 

B) data point 

C) legend 

D) axis 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

22) Each cell in the blue range finder is represented by a ________, which can be a column, a 

bar, a dot, a slice of pie, or other appropriate symbol. 

A) data point 

B) legend character 

C) data marker 

D) data symbol 

Answer:  C 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

23) A unique color or pattern identifying data markers that belong to the same data series is 

displayed in the chart ________.  

A) caption 

B) title 

C) legend 

D) category label 

Answer:  C 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 
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24) A ________ is a prebuilt chart format that applies an overall visual look to a chart. 

A) chart layout 

B) chart style 

C) chart design 

D) chart template 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

25) Chart buttons are displayed when the ________ of the chart is clicked. 

A) border 

B) legend 

C) data marker 

D) caption 

Answer:  A 

Diff: 3 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

26) The ________ button on the Design tab displays the locations where a title and a legend can 

be positioned in a chart. 

A) Chart Style 

B) Change Color 

C) Quick Layout 

D) Add Chart Elements 

Answer:  C 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

27) The ________ dialog box is used to relocate a chart to another worksheet. 

A) Insert Chart 

B) Move Chart 

C) Format Chart 

D) Chart Elements 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 

28) The Chart Elements button displays options for all of these EXCEPT ________. 

A) Chart Title 

B) Data Labels 

C) Chart Caption 

D) Legend 

Answer:  C 

Diff: 3 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 
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29) When a fill option is set in the Format Chart Area pane, the fill color is applied to the 

________. 

A) data marks 

B) data labels 

C) chart title 

D) chart area 

Answer:  D 

Diff: 3 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 

30) The Insert WordArt button is on the ________ tab of the Ribbon. 

A) Home 

B) Insert 

C) Page Layout 

D) View 

Answer:  B 

Diff: 1 

Skill:  Excel Chapter 2, Skill 9: Update Charts and Insert WordArt 

31) When an embedded chart is selected and the worksheet is printed, ________. 

A) only the source data are printed 

B) only the chart is printed 

C) both the source data and the chart are printed 

D) nothing is printed 

Answer:  B 

Diff: 2 

Skill:  Excel Chapter 2, Skill 10: Preview and Print Multiple Worksheets 

32) When Print is clicked from the File tab, the right side of the Print pane is a ________. 

A) review of document properties 

B) list of possible printers 

C) preview of the page to be printed 

D) list of Page Setup settings 

Answer:  C 

Diff: 3 

Skill:  Excel Chapter 2, Skill 10: Preview and Print Multiple Worksheets 

33) Normal View does NOT display ________. 

A) headers and footers 

B) gridlines 

C) the formula bar 

D) row and column headings 

Answer:  A 

Diff: 3 

Skill:  Excel Chapter 2, Skill 10: Preview and Print Multiple Worksheets 
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34) When the mouse is placed in the column heading between the border of columns B and C 

and is dragged to the right, column B becomes narrower. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

35) Both long text entries and long numeric entries are truncated when the column they are in is 

too narrow or when there is content in the column to the right. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

36) When the fill handle is used to copy a cell that contains content that is part of a series, the 

AutoFill feature continues the series in the copy. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

37) Excel uses rules to check for formula errors. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

38) The range finder is used to verify which cells are used in a formula and to edit formulas. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

39) Error values and error indicators CANNOT appear in the same cell. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

40) A formula that attempts to divide by zero displays both an error indicator and an error value. 

Answer:  TRUE 

Diff: 3 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

41) When used on a cell containing a number value, the Decrease Decimal button removes 

decimals from the displayed value and the underlying value. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 
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42) Another way to select a range of cells is to use the arrow keys while holding down the [Ctrl] 

key. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 

43) By default, Excel displays numbers in General format. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 

44) SUM and AVERAGE are the only functions listed in the options displayed by the AutoSum 

arrow. 

Answer:  FALSE 

Diff: 3 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

45) When the AVERAGE function is used, the division operation is NOT visible in the formula 

bar, as it is part of the predefined function. 

Answer:  TRUE 

Diff: 3 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

46) When the data cells are below and to the right of the cell containing a function, the function 

argument is automatically entered. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

47) The AutoFill feature does NOT work with statistical functions. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 5: Insert the MIN and MAX Functions 

48) Cells containing a sum or average are usually included in the MAX and MIN function 

argument. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 5: Insert the MIN and MAX Functions 

49) When there is a change in a cell value in a function argument, the function display value is 

automatically updated to reflect that change. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 5: Insert the MIN and MAX Functions 



10 

50) A chart can be sized by clicking and dragging on its sizing handles. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

51) The range finder uses different colors to identify sections of a selected range that are used to 

create different chart elements. 

Answer:  TRUE 

Diff: 3 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

52) Rows and columns of totals are usually included in a column chart. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

53) Selecting a chart from the Quick Analysis gallery inserts the chart into the active worksheet. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

54) Design and Layout are the only two tabs on the Chart Tools contextual tab. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

55) Once inserted into a worksheet, a chart CANNOT be relocated. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

56) Chart styles and chart layouts affect the same chart elements and features. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

57) When a chart layout is changed, placeholders appear for the elements that have no content. 

Answer:  TRUE 

Diff: 3 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

58) When options are moused over in the Quick Layout gallery, the preview is displayed on the 

actual chart in the worksheet. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 



11 

59) A chart type can be changed after a chart is created. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 

60) Headers and footers CANNOT be inserted into a chart sheet. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 

61) All data labels in a chart can be selected by clicking on one of the data labels. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 9: Update Charts and Insert WordArt 

62) When there is a change in the worksheet data, the corresponding chart is updated 

automatically. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 9: Update Charts and Insert WordArt 

63) Percentages displayed with data labels on a pie chart are NEVER rounded. 

Answer:  FALSE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 9: Update Charts and Insert WordArt 

64) Text created in WordArt is an object, which can be resized and relocated in the worksheet. 

Answer:  TRUE 

Diff: 2 

Skill:  Excel Chapter 2, Skill 9: Update Charts and Insert WordArt 

65) If Quarter 1 is the label in cell B2 and the AutoFill handle is used to copy the content of cell 

B2 through the range C2:E2, what is the content in cell E2 after copying? 

Answer:  Quarter 4 

Diff: 3 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

66) The Wrap Text button is in the Alignment group on the ________ tab. 

Answer:  Home 

Diff: 1 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 

67) AutoFit is applied to a column by double-clicking on the right border of the column in the 

________. 

Answer:  column heading 

Diff: 2 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 
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68) A cell displays a series of ________ when the numeric value displayed is longer than the 

column width. 

Answer:  pound signs (#) 

Diff: 3 

Skill:  Excel Chapter 2, Skill 1: Align and Wrap Text 

69) The ________ indicates an absolute cell reference. 

Answer:  dollar sign 

Diff: 3 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

70) Press the ________ key to close the range finder. 

Answer:  [Esc] 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

71) When a cell formula is being edited, pressing the ________ key changes the selected cell 

reference from relative to absolute. 

Answer:  [F4] 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

72) A green triangle in the upper left corner of a cell is a(n) ________. 

Answer:  error indicator 

Diff: 3 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

73) #DIV/0! is an example of a(n) ________. 

Answer:  error value 

Diff: 2 

Skill:  Excel Chapter 2, Skill 2: Apply Absolute Cell References 

74) If 17.8 is the displayed value in the active cell when the Decrease Decimal button is clicked, 

the displayed value changes to ________. 

Answer:  18 

Diff: 3 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 

75) Clicking the ________ button displays additional decimal values in the active cell. 

Answer:  Increase Decimal 

Diff: 2 

Skill:  Excel Chapter 2, Skill 3: Format Numbers 
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76) The AutoSum button is in the ________ group on the Home tab. 

Answer:  Editing 

Diff: 2 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

77) Numbers, text, cell references, and range names are common examples of a function 

________. 

Answer:  argument 

Diff: 2 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

78) What are the small squares that appear in all four corners of the range finder? 

Answer:  Sizing handles 

Diff: 3 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

79) A function argument is the cell range that appears in ________. 

Answer:  parentheses 

Diff: 2 

Skill:  Excel Chapter 2, Skill 4: Insert the AVERAGE Function 

80) The ________ function evaluates all values in a range and returns the largest value. 

Answer:  MAX 

Diff: 2 

Skill:  Excel Chapter 2, Skill 5: Insert the MIN and MAX Functions 

81) A(n) ________ chart is a chart that is displayed with its source data. 

Answer:  embedded 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

82) When a chart is selected, the ________ contextual tab appears on the Ribbon. 

Answer:  Chart Tools 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

83) Data points related to one another (e.g., first-quarter sales from each region) create 

a(n)________. 

Answer:  data series. 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

84) A(n) ________ chart is best used to illustrate trends over time. 

Answer:  line 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 
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85) Press the ________ key to insert text from a Chart Title or Axis Title placeholder into the 

formula bar. 

Answer:  [Enter] 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

86) A(n) ________ image has the spatial dimensions of length, width, and depth. 

Answer:  three-dimensional 

Diff: 2 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 

87) In the Move Chart dialog box, the default name for a new worksheet is ________. 

Answer:  Chart1 

Diff: 2 

Skill:  Excel Chapter 2, Skill 8: Create and Format Pie Charts 

88) The labels and data series of a chart are linked to the worksheet cells referred to as the 

________. 

Answer:  source data 

Diff: 2 

Skill:  Excel Chapter 2, Skill 9: Update Charts and Insert WordArt 

89) Using ________ can give text a banner-like appearance in a worksheet. 

Answer:  WordArt 

Diff: 2 

Skill:  Excel Chapter 2, Skill 9: Update Charts and Insert WordArt 

90) Print is an option on the ________ tab. 

Answer:  File 

Diff: 2 

Skill:  Excel Chapter 2, Skill 10: Preview and Print Multiple Worksheets 
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Select the description that best matches the chart type. 

A) Illustrates trends over time 

B) Illustrates change in data over time 

C) Illustrates comparisons of individual items 

D) Displays part-whole relationship 

E) Emphasizes magnitude of change over time 

91) Area chart  

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts  

92) Bar chart 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts  

93) Column chart 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

94) Line chart 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

95) Pie chart 

Diff: 2 

Skill:  Excel Chapter 2, Skill 7: Format Column Charts 

Answers: 91) E 92) C 93) B 94) A 95) D 
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Select the description that best matches the chart element. 

A) Horizontal axis of chart 

B) Axis that displays data identifiers 

C) Nonnumeric text that identifies data categories 

D) Vertical axis of chart 

E) Axis that displays the numeric data 

96) Category axis  

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts  

97) Category label  

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts  

98) Value axis  

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

99) x-axis 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

100) y-axis 

Diff: 2 

Skill:  Excel Chapter 2, Skill 6: Create Column Charts 

Answers: 96) B 97) C 98) E 99) A 100) D 


